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Legal
The application bcAdmin was created according to best knowledge and thoroughly 
tested.  Nevertheless its failure free use can not be guaranteed under no circumstance. If 
you encounter errors, we ask you to report these to us so we can try to improve the ap-
plication for you.

We - the Runkel, Marckmann und Schuster gbR - grant you a license to use the applica-
tions, a license that does not entitle you to sell the application to others. Within the first 
30 days starting from the first start of the application it can be used free of charge (trial 
period). after 30 days the applications can only be started with a valid license obtained 
from us.

In no event can we be held liable for any direct, indirect, incidental or any consequential 
damages risen by the use of the software.

Prerequisites

bcAdmin was developed for Apple Computers running OS 10.4 or newer. It runs on PPC 
as well as Intel Macs and expects at least 512 MB of memory. Hard disk size should be 
big enough to hold the recordings from the batcorder.

Contact

Volker Runkel

Runkel, Marckmann & Schuster GbR

ecoObs

Reindelstrasse 2

90402 Nuernberg, Germany

info@ecoobs.com
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1. Quickstart
The following steps show how to load recordings from SDHC card and 

how to analyze them in bcAdmin. This chapters intention is to give you a 

quick headstart, it does not go into detail on how to effectively use 

bcAdmin. We recommend you read the further chapters as well.

1.1. Loading and analyzing recordings

1. Remove the SDHC card from the batcorder and insert it into the card 

reader connected to your Mac. Copy all recordings into a folder on your 

MAc‘s hard disk. Create for example a folder labeled „bcAdminTest“ on 

your desktop and copy the files via the Finder there.

2. Start bcAdmin - the tables will be empty upon first start.

3. Create a new Session by clicking the menu item Session -> Add Ses-

sion (or the + button above the upper table). Edit the session fields and 

make sure that ID (= filecode of the batcorder) as well as date are set 

(required values!). After editing the fields close the sheet. You now have 

the first entry in the upper session table.

4. Make sure the newly created session entry is selected in the table. 

Then click the + button above the lower table to add recordings to this 

session. In the appearing dialog you‘ll have to navigate to the location 

on your hard disc that you copied the files to in step 1. .Select the first 

raw file and press command + A (⌘+A) to select all other recordings. 

Clicking on Open adds the selected recordings to the lower table and 

connects them to the currently selected session.

5. For each imported recording basic information are displayed in the 

lower table (recording time, duration). Click the first recording to select 

it and then press command + A (⌘+A) to select all other recording en-

tries from the table and choose Recordings -> Analyse from the menu 

bar to start analysis of all selected recordings.

6. When this process is finished, bcAdmin has created a csv and a data 
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file for each recording. These are stored together with the raw file on 

disk. In bcDiscriminator you can choose the csv files to create identifi-

cation results (in .res files).

7. After running bcDiscriminator on these files you can switch back to 

bcAdmin and import these results. Make sure all recordings are still se-

lected before you choose from the menu bar Recording -> Import rer-

sults. 

1.2. How to go on ...

You have loaded, analyzed and identified species for your first set of bat-

corder recordings. The steps necessary in this process will be important 

for every other time you choose to add sessions, files or results. bcAdmin 

is based on sessions, thus, it is highly important to get used to store re-

cordings of a single night and batcorder with their own session.

The following chapters deals with more detailed instructions of bcAdmin 

features. You will for example learn how to import files even quicker than 

with the method mentioned above.
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2. Overview of bcAdmin
2.1. Quick overview over bcAdmin features

The management of recordings on a per night and location basis is impor-

tant for the later analysis and interpretation of the available data set. 

bcAdmin allows the simple to use management of recordings. All informa-

tion apart from the actual recording data is saved in a database with a 

high performance. Sound files remain as raw files on the hard disk. Meas-

urement and result files also remain on the disk to allow a simple way of 

backing up these data sets.

Thus, bcAdmin acts as a central container for all recording relevant infor-

mation and from there exports for reports or statistical analysis are possi-

ble. A detailed description of the database can be found at the end of this 

manual.

2.2. Application elements

The main window is split in three main parts, with the session and record-

ings table occupying the main space on the right side of the window. The 

upper half hold all session entries, the lower all recordings of the selected 

session. If multiple sessions are selected, the recordings table stays 

empty. Both tables can be sorted and filtered.

The narrow left bar holds filter. These can be edited via the small symbol 

button in the lower left.
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figure: main window of bcAdmin

3. Creation and Editing of data sets
bcAdmin‘s main task is the management of batcorder sessions and their 

recordings. All available fields (session, recording) are useful for later data 

analysis and filtering and thus, should be filled as completely as possible. 
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3.1. Quick intro to loading files/data

The following steps are to outline the process to add new recordings. An 

automated way will be explained later.

1. Create a location (if not already available)

2. Create a session and edit the necessary fields

3. Copy recordings from SDHC card to your Mac

4. Add the copied recordings to the session

5. Analyze the selected recordings

3.2. Locations

Locations can be maintained with the Locations-Editor. You can access 

the editor via a button in the toolbar, via Window -> Editor Windows -> 

Locations or from within the sessions editor sheet. The locations editor 

contains all available locations (left part of the window) and each of these 

can be selected and edited. Details are therefore displayed in the right 

window half.

figure: Location-Editor
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The number in the last column of the list of all locations shows the num-

ber of sessions that were recorded for this location. To edit the details of 

the selected location you have to activate edit mode via the button below 

the table. Further buttons allow duplication of a selected location, addi-

tion of a new and empty location or deletion of selected locations.

Coordinates can be written in decimal form or in the form of XX° XX' 

XX.XXXX". These are expected to be in UTM WGS84 format and can be 

shown in a google map via the button Show Map. The coordinate entries 

are used to calculate sunset and sunrise times.

3.3. Sessions

When importing recordings the first step always should be the creation of 

a session. Using the + button above the session table a new and empty 

session entry is created. The * button duplicates an existing entry. After 

one of these actions the session editor pops up automatically and allows 

the editing of the session fields. 

figure: Session-Editor

If all necessary entries were made the sheet can be closed and recordings  
can be added. By double click on a session in the table you can always 
reopen the sheet and edit the fields. There are other possibilities to open 
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the sheet via the toolbar or the windows menu.

From within the session editor you have quick access to the locations edi-
tor. The button Set from Session Date allows to quickly fill the From and 
To with the session date, which hold start time and stop time of the data 
acquisition period. If the connected location has entries for x/y coordinate, 
the sunset and sunrise time can be calculated by pressing Get from Loca-

tion. Via the Finder  ( ) button the sessions file location can be opened 

in a Finder window. The magnify tool ( )  allows to reset the file location.

Note: If the file location is set improperly, the recordings can not be ana-
lyzed and calls can not be displayed! Change this setting only if you have 
moved the files on your hard disk.

If you have moved recordings for multiple sessions on your hard disk, 

bcAdmin offers the possibility to relocate the file location entries for mul-

tiple sessions easily. First, select all sessions you want to change. Then 

open the session editor via the toolbar button. Most entries will be dis-

played with „Multiple values“ since you have chosen more than one ses-

sion. Now click the magnifying glass tool. bcAdmin analyzes the file loca-

tions of all selected sessions and extracts the common path. it now al-

lows to relocate the common path to a new location and reconnects all 

session‘s file locations again. 

3.4. Recordings

batcorder recordings (raw files) are the main reason to use bcAdmin. 

These recordings should always be connected to a unique session. Thus, 

they can only be added to the database if a session exists and is se-

lected. Using the + button above the lower table a dialog opens and you 

can choose the raw files you wish to import. 

When importing recordings the session‘s file location is set automatically, 

and you receive a warning if recordings from another location were al-

ready imported to this session.

The import process automatically reads the file creation/modification date 
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as well as the length to determine the sound duration. Double clicking a 

recording entry opens the recording editor sheet and displays recording 

details. These are entries like species 1 to species 3 and their probabili-

ties. Some fields are secured and can not be edited manually. 

figure: Recording-Editor

If bcDiscriminator results were imported already, these are displayed for 

each of the three possible species entries. If call measurements are avail-

able (.data file), a button to display a call preview is available (Calls). 

This call preview or display plots the measurements per call in a sona-

gram like view. Call intervals are omitted. If bcDiscriminator 1.14 was 

used, species and probability for each call are added to the display (new 

feature since 1.15).
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figure: call display window

4. Working with recordings and call analysis
4.1. Automated recordings import

To simplify the import of recordings a special import function exists. This 

function analyses the content of the SHC card and generates per 24 hour 

intervals (12 to 12)  list of potential sessions and their recordings. To start 

this process you have to insert the batcorder SDHC card and click on the 

blue SD card icon1 in the lower window half. In the first step the SDHC 

card has to be located in a file choose dialog. Per default it is displayed in 

the left column of the window next to hard disk and other storage vol-

umes.
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figure: choosing the SDHC card for automated import

After analyzing the SDHC cards content a list of all possible sessions is 

displayed. Here you can choose single or multiple sessions which should 

be added with the same meta information to the database. Each session 

that gets imported is removed from the list. As long as the list is not 

empty, you can repeat the selection and import of locations. Cancel also 

closes the window.

For importing a couple of details can be pre-filled. Amongst are editor or 

reason. Required is a target folder on your hard disk. If multiple sessions 

were selected you can choose to copy the recordings to subfolders within 

the target folders automatically. These subfolders are named with the 

session date in the form of YYMMDD automatically. 
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figure: auto import from SDHC card

figure: auto import details
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4.2. Find and measure calls

One task of high importance within bcAdmin is the search and measuring 

of calls within recordings. It allows to search for calls of all recordings of a 

session using a similar algorithm as the batcorder. All calls are saved with 

their measurements in a data file (call measures over time) and a csv file 

for species identification using bcDiscriminator. 

Use Recording -> Analyse to start the process. It is important, that the 

files reside at the folder set as file location in their session. Furthermore 

the folder must be writable to, otherwise data and csv files can not be 

produced. Thus, recordings stored for example on DVD can be analysed, 

but no files can be written for identification etc. . When measuring the 

calls, call count is set as well as a check in the column analyzed and an 

entry in species1. This is usually Spec. (bat calls), No Calls (no calls 

found) and if calls of Rhinolophus species were detected either Rhip or 

Rfer. These two are missing in bcDiscriminator in its current form, thus 

bcAdmin looks for these two species and adds them if they are found.

4.3. Import of bcDiscriminator results

bcDiscriminator uses files created by bcAdmin and saves the results in 

files ending on .res at the same location as the csv files are located. 

These results can then be imported again into bcAdmin via Record -> 

Import Results. The import process extracts species 1 to 3 with relevant 

probabilities and saves them for each recording. If these results are later 

changed manually, the probabilities and such are removed again.

An alert is displayed if not for each recording a result file was found. This 

indicates either some recordings with no calls and thus no csv file or an-

other problem that occurred. When the import is started all previous en-

tries are also deleted to avoid a mix of results of different analysis runs.

4.4. Further methods for working with recordings

Within the menu item Recordings some more tools are available. One is 
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Calc per Nite which uses the nights duration to calculate a percentage of 

appereance of the recording within the night based on the recording time. 

Using Adjust Time it is possible to shift recording times forward or back-

ward in time. This is useful if the batcorder had a wrong time set. Last but 

not least Remove Results allows to empty the fields that are otherwise 

filled in the analysis process.

5. Data export
For exporting data a couple of methods are available. Usually these are 

designed in such a way that they include data from the selection. Thus, it 

is necessary to select data sets before export is initiated.

5.1. Menu item "Export"

5.1.1. Export -> Selected Sessions

This methods allows to export selected fields of sessions. using an assis-

tant the fields and their order can be selected and either exported to clip-

board or to a csv file. Starting with version 1.15 bcAdmin saves the field 

and order information and restores it for the next export event.
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figure: Export of sessions; field selection

5.1.2. Export -> Selected Recordings

The same method as described before, this time based on the selected 

recordings, or, if multiple sessions were selected, for all recordings of 

these sessions.

5.1.3. Export -> Location Export

Export of all locations.

5.2. Graphical display of nightly activity

For reports you can create graphs that display the activity recorded for a 

session throughout the night. Just select the interesting recordings and 

create or just a single one for computing the whole night. In the opening 

window you can manipulate the display in different ways, like choosing 

other bin widths or selecting/deselecting single species. Recordings with 
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no species entry or no calls are not plotted. The graph can be exported to 

PDF, copied to the clipboard or the values of each bin can be exported as 

csv data.

figure: activity graph

If information on start/stop and sunset/rise are available, these are plotted 

as green (time frame with acquisition) and gray (sunset/rise) areas behind 

the bars.

5.3. Report Assistant

The report assistant allows to extract and summarize data for reports. The 

most interesting function is to combine and plot multiple sessions. Differ-

ent fields can act as combination value.
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5.3.1. Combining or summarizing activity

You can combine different sessions for a single report table. Using the 

popup activity based on you can switch which species niveau should be 

used for the resulting table. By choosing Session, Date, or Reason you 

can choose which field acts for combining sessions in the report. Fur-

thermore you can use different activity measurements.

figure: Report Assistant

If HTML is chosen as output format, it is displayed directly. RTF/Word re-

ports are written to file.

6. Further Functions and facts
6.1. More than one database file

By default bcAdmin stores all information in a single database file. You 

can choose to create additional files for storing project relevant sessions 

etc. in these. File -> Save As or File -> New can be used to create new 

database files.
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At the moment different database files can not be merged. This a feature 

that we have planned for future releases.

6.2. Default database location

bcAdmin saves the main database file per default to the folder Library/

Application Support/bcAdmin within your user folder. We recommend 

you do regular backups of this folder to avoid loss of data in case of a 

crash.
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7. Preferences
The available preferences of bcAdmin allow to customize some of its be-

haviour:

7.1. General Preferences

The general preferences customize the looks of bcAdmin:

figure: general preferences

Indicate sessions with non-existent file location: If this box is checked 

entries in the session table are highlighted if thir file location could not be 

located on the disk. This is useful to identify sessions which files were 

copied or deleted easily. Auto-Backup creates backup files at defined 

intervals if the checkbox is set. The backup files are saved to the folder ~/

Library/Application Support/bcAdmin/Backups. Activating Quick dis-

crimination enables a first, very simple species identification. This is 

rather inaccurate and is not a replacement for bcDiscriminator. It is deac-

tivated per default, then only Rhip and Rfer (Rhinolophids) are detected 

and reported. For older Apple computers you can increase the perform-

ance of the Call preview by activating a faster display routine. You can 

also choose the amount of performance improve, which goes with a loss 

of accuracy since some measurements within calls are omitted.
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7.2. Preferences: "Files"

Here you can choose how to deal with files in various functions of bcAd-

min.

figure: Files preferences

(Measurement files:

• Original measurements per call are saved to an XML file (.data), these 
are used for the call preview in bcAdmin and bcAnalyze

• Derived measurements are saved to csv files and used by bcDiscrimina-
tor

• Measurements of all recordings are written to one large single file

You can choose to use creation or modification date of files for setting the 

time entry in recordings.

If Delete files when deleting recording entries is selected, recording 
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files are deleted whenever you remove recordings from the recordings ta-

ble. There is no undo for this step!

7.3. Reports

You can set the time frame used for calculations (night/acquisition time) 

as well as preset the data format for exporting csv files.

figure: Report preferences

7.4. Sound Analyser

The settings here are to be changed only with caution, since they influ-

ence the call finder as well as the measurement algorithm. Wrong settings 

may lead to unusable results  for identification:
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figure: preferences of the Sound Analysers

Zero Crossing Analysis

After finding calls with in the recording these get measured using a form 

of zero-crossing analysis. In this process call quality parameters are 

evaluated.

• Regression size = 300 µs, for signal detection and smoothing of meas-
urements

• MSE = 0.4, influences the accuracy of frequency computations
• Get Hysterese automatically: either use a percentage of the noise in 

the recording or a fixed amplitude value (in percent)
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Call Finder

These settings influence the finding of calls within the recording:

• Amplitude threshold = 4.5%, amplitude a call has to reach at minimum 
to be accepted as a call. It is given as percentage of full amplitude. If the 
batcorder is set to -27 dB this would be for example ca. 4.5%. Please 
choose a value according to the settings of the batcorder

• Smoothness = 2.0, the same as Quality in the batcorder, it determines 
when a signal is a bad call and when not.

• Samples Hi = 200, another quality measurement
• Min. call distance = 15 ms, minimum distance between signals so they 

are accepted as calls.
• Min. call length = 1.5 ms, minimal call lenght, shorter calls are not ana-

lyzed

Call extraction

The computation of measurements can be influenced with the following 

settings:

• Min. call interruption = 1.10 ms, interruption within calls that is still ac-
cepted and interpolated.

• Forward MSE = 0.06, influences when to stop measuring based on call 
quality

• Samples for regr = 8, influences when to decide that a call ends
• Regression size = 200 µs, is important for the measurement creation 

over the call duration
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8. Licensing
To use bcAdmin after the trial period of 30 days you need to obtain a li-

cense from Runkel, Marckmann und Schuster GbR. The license is bound 

to a single Mac. To achieve this, bcAdmin evaluates the Mac serial num-

ber and creates a hash number from it. Based on this number we create a 

license file that can be used to activate the application. Therefore we 

need this number to send you a license file. 

From this number we cannot recreate the serial number, thus it is save to 

send it to us. We gain no knowledge of your Mac. If you need further li-

cense for computers that are for example used in the field, we may give 

out a second free license, but we have to decide this for each single case. 

We can not give out free licenses if two computers are used more or less 

simultaneously.
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9. Database structure
To help you understand bcAdmin‘s inner working better, we explain the 

main database tables in this chapter. Three tables are used to store all the 

data. These are a locations table, a sessions table and a recordings table. 

The following figure gives a draft overview of their connection:

SESSION LOCATION

ID
Datum
Wetter
Sonne/Mond
...

RECORDINGS

Dateiname
Uhrzeit
Artinfo
...

Name
Umgebung
Habitat
Geo-Koord.
...

Tabellen- und Datenbank-
schema von bcAdmin

figure: database schema (simplified)

9.1. Sessions

Acquisition of activity with the batcorder usually happens for a whole 

night at a single location - this unit we call session. A session is always 

bound to a date and has a unique id, resembling the batcorder file code 

to allow for quick recognition of recordings. Furthermore information on 

weather, sun times and such are stored in this table for each session.

Table: Fields for sessions, automatically filed fields are backed gray

1. Name 1. Typ 1. Beschreibung

ID String 
(10 tokens)

Descriptor of the session, optimally set to the 
batcorder file code

Date date date of acquisition
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1. Name 1. Typ 1. Beschreibung

Reason String Reason for acquisition

Editor String Editor: name or abbreviation

From date/time Start of sampling

To date/time end of sampling

Sunset date/time Sunset

Sunrise date/time Sunrise

Temp (max) number max temperature

Temp (min) number min temperature

Clouds String cloud status

Wind String wind

Rainfall String rainfall

Moon number moon

Comment String comment

Settings String batcorder settings

Samplerate number samplerate of the recordings

Filelocation String path for recordings

Location relationship link to the location

9.2. Locations

The location table contains all locations and relevant information.

Table: Fields for locations, automatically filed fields are backed gray

1. Name 1. Typ 1. Beschreibung

Link string name, concatenation of location and city

Location string location name
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1. Name 1. Typ 1. Beschreibung

City string closest city

District string district

Region string region

X-Coord number longitude

Y-Coord number latitude

Structure string location habitat structure

Habitat string location habitat

9.3. Recordings

An entry of the recordings table holds all information related to a single 

recording.

Table: Fields for recordings, automatically filed fields are backed gray

1. Name 1. Typ 1. Beschreibung

Filename string file name of the recording

Length number lenght in seconds

Rec. time time time of the recording

Analyzed Bool shows if calls were analyzed

Look at Bool marker for interesting recordings

Species1,2,3 string first, second, third species

Prob 1,2,3 number probabilites for 1st to 3rd species

Pre 1,2,3 string identification result before species was reached

Pre prob 1,2,3 number probabilites for the pre1 to pre3 entries

Comment string comment
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10. Tips & Tricks
We have not included a full recording file management into bcAdmin (like 

iTunes for example does). That way you are free to create your own folder 

structure according to your requirements. Some of our tipps on how to 

use bcAdmin effectively are summarized in this chapter.

10.1. folder structure for recordings

For reasons like backup of recordings and for a good overview of files we 

recommend a folder structure similar to the one described in the follow-

ing. It is best to have one folder on your hard disk labeled recordings. 

Within this folder a structure mirroring your projects sits at the top level. 

Within each of these projects you can create a folder for each recording 

location. In these the recordings are collected, each session in its own 

folder.

Recordings	 ProjectA	 SESSIONA

	 ProjectB	 SESSIONA

	 	 SESSIONB	 070507

	 	 	 070607

	 	 	 070729

	 	 SESSIONC

	 	 	 080607

	 	 	 080609

	 	 	

	 ProjectC	 SESSIONX

This scheme has proven useful for archiving recordings and for quickly 

finding recordings again.
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